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INTRODUCTION

The Expungement Guide, developed and presented by the Juvenile Court Judges’ Commission (JCJC),
is an essential resource created to support juvenile justice practitioners in Pennsylvania. This guide offers
a comprehensive overview of the statutes, rules, standards, policies, and resources relevant to the
expungement of juvenile records across the Commonwealth.

There is a common misconception that juvenile court records remain confidential or are automatically
destroyed once a juvenile reaches adulthood. In reality, these records can have significant consequences
on an individual’s future if not properly expunged.

This guide is designed to help juvenile justice system professionals within Pennsylvania understand
the various types of records created through ajuvenile’s involvement with law enforcement and the courts.
These records include law enforcement reports, fingerprints, juvenile probation files, court documents,
and deoxyribonucleic acid (DNA) records. Such information is maintained by juvenile probation offices,
law enforcement agencies, clerk of courts offices, and other related agencies.

The proper handling and sharing of juvenile court records is critically important. Juvenile court
dispositions and related records may result in collateral consequences such as the loss of driving

privileges, restrictions on certain careers including military service, challenges in gaining admission to
post-secondary education institutions, prohibitions on purchasing or possessing firearms, and impacts
on sentencing in future criminal cases through prior record scoring.

The MacArthur Models for Change Initiative, Pennsylvania Juvenile Justice System Enhancement
Strategy (JISES), Pennsylvania Juvenile Justice Task Force, and Act 108 of 2024 contributed to the
emergence of systemic changes and best practices for the expungement of juvenile court records.

Act 108 of 2024 significantly strengthened Pennsylvania’s juvenile expungement framework by
clarifying timelines, expanding procedural safeguards, and placing structured responsibilities on juvenile
justice system agencies to ensure eligible youth receive the benefit of record relief.

The Act contributed to systemic change in several important ways:

* Enhanced notification requirements: the Act formalized obligations for juvenile probation offices,
particularly chief juvenile probation officers, to review cases and initiate notification when youth
become eligible for expungement.

e Structured timelines: the Act reinforced designated time-based eligibility standards, reducing
ambiguity and promoting more consistent statewide application.

e Administrative accountability: the Act encouraged counties to adopt tracking mechanisms and
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standardized processes rather than relying on informal or manual reviews by requiring documented
review and action.

e Promotion of uniformed best practices: the Act prompted development of tools such as
expungement dashboards and written county policies to ensure compliance, transparency, and
equity across jurisdictions.

Overall, Act 108 of 2024 represents a shift from discretionary, case-by-case expungement practices
toward a more proactive, system-driven model designed to improve fairness, reduce long-term collateral
consequences for youth, and ensure consistent implementation across Pennsylvania counties.

This guide includes best practice recommendations for managing juvenile court records and provides
information regarding the procedures for expungement as set forth by the Pennsylvania Supreme Court
and the statutes that govern the expungement process.

Juvenile Court Judges’ Commission
Pennsylvania Judicial Center | 601 Commonwealth Avenue, Suite 4600
P.O. Box 62425 | Harrisburg, PA 17106 | 717.787.6910 | F. 717.783.6266 | www.pa.gov/agencies/jcjc



https://www.pa.gov/agencies/jcjc

PURPOSE

The primary purpose of this guide is to provide juvenile justice practitioners, court personnel, and
justice system stakeholders with clear, accurate, and practical guidance on the identification,
management, and expungement of juvenile records in Pennsylvania. This guide is intended to promote
consistent statewide practices by explaining applicable statutes, Pennsylvania Rules of Juvenile Court
Procedure (Pa.R.J.C.P.), and best-practice standards governing juvenile court records, law enforcement
records, fingerprints, photographs, juvenile history record information, DNA records, and related
collateral consequences.

In addition, this guide is designed to support timely and appropriate expungement decisions, reduce
unnecessary long-term barriers for youth, and ensure that record retention and disclosure practices align
with the rehabilitative purposes of the Juvenile Act. The guide seeks to enhance compliance, protect
confidentiality, promote public safety, and advance fair and developmentally appropriate outcomes for
youth involved in Pennsylvania’s juvenile justice system by clarifying legal requirements, procedural
responsibilities, and system coordination expectations.

This guide reflects the JCJC’s unwavering commitment to excellence in juvenile justice leadership,
accountability, and youth development. Itis updated regularly to ensure juvenile justice practitioners have
access to the most relevant and effective practices available.
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JUVENILE RECORDS AND FILES

Access to court records regarding juveniles who have involvement in the juvenile justice system is
governed by the Juvenile Act (42 Pa.C.S. Chapter 63) and the Pa.R.J.C.P. This section of the guide will
define the different types of juvenile court records; explain who may inspect files, records, and reports;
and describe the circumstances under which limited information may be provided to the public.

Definitions

The terms “Official Court Record” and “Juvenile Probation Files” have been defined in the Pa.R.J.C.P.,
as follows:

Official Court Record (previously referred to as Juvenile Court Files) is the juvenile court file maintained

by the clerk of courts which contains all court orders, court notices, docket entries, filed documents,
evidence admitted into the record, and other court designated documents in each juvenile case.’

Juvenile Probation Files (previously referred to as Juvenile Probation Records and Reports) are those
records formally maintained by the juvenile probation office and its officers, including, but not limited

to, copies of information contained in the official juvenile court record; social studies; school records
and reports; health evaluations, screenings, assessments, records, and reports, including
psychological and psychiatric evaluations and reports, drug and alcohol testing, evaluations, and
reports; placement reports and documents; employment records; and probation reports.?

Inspection of Official Court Records

The Pa.R.J.C.P. and the Juvenile Act set forth who may inspect official court records.? Official court
records are open to inspection only by:

e thejudges, juvenile court hearing officers, juvenile probation officers, and staff of the court;

* the attorney for the Commonwealth, the juvenile’s attorney, and the juvenile, but the persons in
this category shall not be permitted to see reports revealing the names of confidential sources of
information, except at the discretion of the court;

* a public or private agency or institution providing supervision or having custody of the juvenile
under order of the court;*
* a court, its probation officers, other officials or professional staff, and the attorney for the

"See Pa.R.J.C.P. 120 and Pa.R.J.C.P. 166.
2See Pa.R.J.C.P. 120.
3See Pa.R.J.C.P. 160 and 42 Pa.C.S. § 6307(a).
4The term “supervision” in this context should be interpreted broadly to include responsibility, oversight, or other authority over a juvenile,
granted pursuant to an order of court.
February 2026 Page 1
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defendant for use in preparing a pre-sentence report in a criminal case in which the defendant is
convicted and the defendant previously was adjudicated delinquent;

* ajudge orissuing authority for use in determining bail, provided that such inspection is limited to
orders of delinquency adjudications and dispositions, orders resulting from dispositional review
hearings, and histories of bench warrants and escapes;

* the Administrative Office of Pennsylvania Courts (AOPC);

e the judges, juvenile probation officers, and staff of courts of other jurisdictions when necessary
for the discharge of their official duties;

e officials of the Department of Corrections, a state correctionalinstitution or other penalinstitution
to which an individual who was previously adjudicated delinquent in a proceeding under the
Juvenile Act has been committed, but the persons in this category shall not be permitted to see
reports revealing the names of confidential sources of information contained in social reports,
except at the discretion of the court;

e aparole board, court, or county probation official in considering an individual who was previously
adjudicated delinquent in a proceeding under the Juvenile Act, but the persons in this category
shall not be permitted to see reports revealing the names of confidential sources of information
contained in social reports, except at the discretion of the court;

e the State Sexual Offenders Assessment Board for use in completing assessments; and

e with leave of court, any other person, agency, or institution having a legitimate interest in the
proceedings or in the work of the unified judicial system.

It is critical that courts establish written policies and procedures governing the inspection of official
courtrecords, especially with regard to records that are open to inspection only with leave of court (formal
permission from a judge).

Inspection of Juvenile Probation Files

The Pa.R.J.C.P. and the Juvenile Act set forth who may inspect juvenile probation files. Juvenile
probation files are open to inspection only by:

e thejuvenile or the juvenile’s attorney of record in the instant proceeding;
e the attorney for the Commonwealth;
e the State Sexual Offenders Assessment Board;

e thelCIJC;or
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e anyother person, agency, or department by order of court. ®

It is critical that courts establish written policies and procedures governing the inspection of juvenile
probation files.

Authorizing the Inspection of Official Court Records and Juvenile Probation Files

How a court determines whether to grant an individual or agency the opportunity to inspect official
court records and juvenile probation files, if the individual or agency is not statutorily entitled to do so, is
important. Itis imperative, therefore, for courts to have objective criteria and consistent policies governing
the inspection of official court records and juvenile probation files. Recommendations in this regard are
set forth in the JCJC Standards Governing the Release of Information Contained in Juvenile Court Files and
Juvenile Probation Records or Reports.®

According to the JCJC Standards Governing the Release of Information Contained in Juvenile Court
Files and Juvenile Probation Records and Reports, requests for access to, or copies of, official court
records or juvenile probation files should be in the form of a motion to the court that specifies the
information being sought and the purpose for which the information will be used. In determining whether
to grant the motion, the court should consider:

¢ the purpose for which the information will be used;

the nature of the information requested;

e administrative or legislative authority governing the release of the information;

the nature of the offense; and

the impact that the release of the information would have on the juvenile and the community.’
Dissemination of Official Court Records and Juvenile Probation Files

The JCJC Standards Governing the Release of Information Contained in Juvenile Court Files and
Juvenile Probation Records and Reports recommend that courts adopt written policies and procedures
governing the dissemination of official court records and juvenile probation files. It is recommended that
policies include a requirement that a representative from the juvenile probation office must be present
throughout the inspection of juvenile probation files, and that the representative be responsible for the
duplication of juvenile probation files. Juvenile probation offices should maintain a case-specific written
record listing the names and addresses of individuals to whom copies are provided. A statement
prohibiting the secondary dissemination of information should accompany juvenile probation files

5See Pa.R.J.C.P. 161 and 42 Pa.C.S. § 6307(a).
8 Juvenile Court Files are now referred to as Official Court Records and Juvenile Probation Records and Reports are now referred to as
Juvenile Probation Files.
7 See 37 Pa. Code § 200.802(b)(2).
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provided to individuals.® It should be noted that drug and alcohol treatment information should not be
disseminated without the written consent of the juvenile. Absent a written consent, drug and alcohol
treatment may only be disseminated with a court order issued upon a showing of good cause.®

Release of Information to Schools

The Juvenile Act, the Pa.R.J.C.P., and the JCJC Standards set forth provisions relating to the release of
information to schools.’ When a juvenile is adjudicated delinquent, the court shall, through the juvenile
probation office, provide the following information to the building principal, or a designee, of any public,
private, or parochial school in which the child is enrolled:

e npame and address of the child;

¢ the delinquent acts that the child was found to have committed,;
e abrief description of the act; and

¢ the disposition of the case.

In addition to the information listed above, the juvenile probation office shall provide notice of the
following:

e astatementinforming the building principal or designee that information received:
o shall be maintained separately from the juvenile’s official school record;
o isforthe limited purposes of:
= protecting school personnel and students; and
= arranging for appropriate counseling and education for the juvenile;
o0 may not be used for school disciplinary decisions concerning the juvenile unless:
= the juvenile was under the supervision of the board of directors at the time of the incident;

= the act or acts that were substantiated by the court took place on or within 1,500 feet of the
school property; and

= the school has complied with all other statutory regulatory, and constitutional provisions
relative to the imposition of school discipline; and

o shall be shared with the juvenile’s teachers.

8See 37 Pa. Code § 200.802(c).
9See 42 CFR Part 2 § 2.14(b), 71 P.S. § 1690.108, and 4 Pa. Code § 255.5.
0See 42 Pa.C.S. §6341(b.1), Pa.R.J.C.P. 163, and 37 Pa. Code § 200.803.
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e astatementinforming the building principal or designee of the requirement to:

0 maintain a log of all school district employees, or building principals or their designees from
other school districts, to whom this information was subsequently provided when a juvenile
was transferred to another school; and

o provide the new school with a copy of the notice previously provided to the old school.™

When a juvenile is adjudicated delinquent for a felony, the juvenile probation office must also provide
relevant information in the juvenile probation or treatment reports pertaining to the adjudication, prior
delinquent history, and the supervision plan of the juvenile. Additional information may likewise be
provided to the principal or designee by the juvenile probation office as deemed necessary to protect
public safety or to enable appropriate treatment, supervision, or rehabilitation of the juvenile.'?

Public Availability

Under certain circumstances, the public is entitled to receive limited information regarding juvenile
court proceedings. The Juvenile Act and the Pa.R.J.C.P. set forth criteria under which information may be
released to the public, the specific information that may be released, and procedures regarding the
release of such information. ™

Public Disclosure of Information Based Upon an Adjudication of Delinquency

The Juvenile Act and the JCJC Standards Governing the Release of Information Contained in Juvenile
Court Files and Juvenile Probation Records and Reports provides that the public is entitled to receive
certain information when a child has been adjudicated delinquent for act(s) committed when the child
was 14 years of age or older. The same applies when a child has been adjudicated delinquent for act(s)
committed when the child was 12 or 13 years of age and the conduct would have constituted one or more
of the following offenses if committed by an adult:

e Murder.

¢ Voluntary manslaughter.

e Aggravated assault as defined in 18 Pa.C.S. § 2702(a)(1) or (2) (relating to aggravated assault).
e Sexual Assault as defined in 18 Pa.C.S. 8 3124.1 (relating to sexual assault).

e Aggravated indecent assault as defined in 18 Pa.C.S. § 3125 (relating to aggravated indecent
assault).
e Arsonasdefinedin 18 Pa.C.S. 8 3301(a)(1) (relating to arson and related offenses).

1 See Pa.R.J.C.P. 163.
2See Pa.R.J.C.P. 163(C).
3 See 42 Pa.C.S. §6307(b) and Pa.R.J.C.P. 160(B).
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e Burglary as afelonyin the first degree as defined in 18 Pa.C.S. 8 3502(c)(1) (relating to burglary).
¢ Involuntary deviate sexualintercourse (IDSI).

¢ Kidnapping.

e Rape.

e Robbery as defined in 18 Pa.C.S. 8 3701(a)(1)(i), (ii), or (iii) (relating to robbery).

e Robbery of motor vehicle.

¢ Violation of 18 Pa.C.S. Chapter 61 (relating to firearms and other dangerous articles).

e Attempt or conspiracy to commit any of the offenses above.™

When the aforementioned criteria are met, the Pa.R.J.C.P. require the court to include a designation
onthe dispositional order as to whether the case is eligible for limited public information.' The Pa.R.J.C.P.
also provide that, upon request, the clerk of courts is to create a public document if the case is deemed
eligible for public inspection, which includes the following information:

* thejuvenile’s name;

* thejuvenile’s age;

e thejuvenile’s address;

e the offenses alleged in the petition;

e the adjudication on each allegation; and
* the disposition of the case.

Release of information to the public is based, in large part, upon the offense. Therefore, it is critical
that courts make determinations regarding all offenses alleged in the petition. Courts are required to
specify the particular offenses which the juvenile has been found to have committed, including the grading
and counts thereof, on the record.’

Public Disclosure of Information Based Upon a Petition Alleging Delinquency

Public disclosure of certain information contained in court files may also occur when a petition alleging
delinquency has been filed in certain cases. This applies to juveniles who are 14 years of age or older at
the time of the currently alleged offense, and the offense would be a felony if committed by an adult, and
if the juvenile has a previous adjudication of delinquency for a felony offense committed when the juvenile

4 See 42 Pa.C.S. § 6307(b)(1.1)(i) and 37 Pa. Code § 200.804.
5 See Pa.R.J.C.P. 515(A)(2).
16 See 42 Pa.C.S. § 6307(b)(1.1)(i) and Pa.R.J.C.P. 160(D).
7 See 42 Pa.C.S. § 6341(b) and Pa. R.J.C.P. 408.
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was 14 years of age or older, or if the juvenile was adjudicated delinquent when the child was 12 or 13
years of age for one of the following offenses; or when a petition alleging delinquency has been filed and
the juvenile was 12 or 13 years of age at the time of the offense, the alleged conduct constitutes one or
more of the following offenses, and the juvenile was previously adjudicated delinquent for any one of these
offenses committed when the juvenile was age 12 or 13:

e Murder.

¢ Voluntary manslaughter.

e Aggravated assault as defined in 18 Pa.C.S. § 2702(a)(1) or (2).
¢ Sexual assault as defined in 18 Pa.C.S. 8 3124.1.

e Aggravated indecent assault as defined in 18 Pa.C.S. § 3125.
¢ Arson as definedin 18 Pa.C.S. 8 3301(a)(1).

e Burglary as afelony in the first degree as defined in 18 Pa.C.S. § 3502(c)(1).

e |DSI.
e Kidnapping.
e Rape.

e Robbery as definedin 18 Pa.C.S. 8 3701(a)(1)(i), (ii), or (iii).

¢ Robbery of motor vehicle.

¢ Violation of 18 Pa.C.S. Chapter 61.

e Attempt or conspiracy to commit any of the offenses in this subparagraph.™

When the aforementioned criteria are met, the Pa.R.J.C.P. require that the petition contain an
averment as to whether the case is eligible for limited public information pursuant to 42 Pa.C.S. § 6307
(b)(1.1)(ii)."™ The Pa.R.J.C.P. also provide that, upon request, the clerk of courts is to create a public
document if the case is deemed eligible for public inspection. The public document is to contain only the
following information:

e thejuvenile’s name;

e thejuvenile’s age;

8 See 42 Pa.C.S. § 6307 (B)(1.1)(ii) and 37 Pa. Code § 200.804(c).
°See Pa.R.J.C.P. 330(C)(14).
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* thejuvenile’s address; and
e the offenses alleged in the juvenile’s petition.?°

Employment and Military Service

Prospective employers, military recruiters, and others conducting background checks frequently make
requests for juvenile court information. However, unless public availability criteria are met, the JCIC
Standards Governing the Release of Information Contained in Juvenile Court Files and Juvenile Probation
Records and Reports require a court order be obtained to authorize the release of such information.?' A
court order authorizing the release of information should be required, even in cases where the recruiter
has a signed release from the juvenile.

All branches of the military have regulations governing the eligibility of persons who have had
involvement in the juvenile justice system. Juveniles who have had involvement in the juvenile justice
system should review the eligibility requirements for the branch in which they intend to enlist.

Collateral Consequences

The Juvenile Act provides that an order of disposition, or other adjudication, in a proceeding under the
Juvenile Actis not a conviction of a crime and does not impose any civil disability ordinarily resulting from
a conviction or operate to disqualify the child in any civil service application or appointment.??2 However,
juvenile court dispositions may affect a person in a variety of ways.

Subsequent Judicial Matters

The Juvenile Act indicates that juvenile court dispositions may be considered in subsequent judicial
matters under the following circumstances:

* in disposition proceedings after conviction for the purposes of a presentence investigation and
report if the child was adjudicated delinquent;

* inasubsequentjuvenile hearing, whether before or after reaching majority;
* ifrelevant, where the juvenile has put their reputation or character in issue in a civil matter; or

* inacriminal proceeding, if the juvenile was adjudicated delinquent for an offense, the evidence of
which would be admissible if committed by an adult.?

Post-Secondary Education

Admission to post-secondary institutions including colleges, universities, and vocational or trade

20See 42 Pa.C.S. § 6307(b)(1.1)(ii) and Pa.R.J.C.P. 160(D).
21See 37 Pa. Code § 200.802.
22See 42 Pa.C.S. § 6354(a).
2 See 42 Pa.C.S. § 6354(h).
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schools may be impacted by involvement with the juvenile justice system. Although an adjudication of
delinquency does not prevent access to post-secondary education, if the institution’s application
requests the individual’s arrest history, juvenile arrests must be included.

Colleges and universities are increasingly using a standard application, known as the “Common
Application.”?* On August 1, 2019, the collection of criminal history information was removed from the
Common Application. However, the Common Application’s member institutions continue to be able to
collect criminal history information on their individual member screens if they choose. The student
disciplinary history question remains on the common portion of the application. However, if asked about
juvenile court dispositions or criminal history, a juvenile may answer “no” when asked whether they have
been convicted of a crime. The Juvenile Act makes clear that an order of disposition or adjudication in a
juvenile proceeding is not considered a conviction and does not impose the civil disabilities that ordinarily
result from a criminal conviction.?®

Suspension of Motor Vehicle Operating Privileges

This section includes information on circumstances where motor vehicle operating privileges may be
suspended. Juveniles not having a license at the time of suspension are ineligible to apply for a driver’s
license for the time period specified by the license suspension. If a juvenile is under the age of 16 when a
license suspension is ordered, the suspension will commence automatically upon the individual’s 16"
birthday for the specified period of time if an acknowledgement is received any time prior to the
individual’s 16" birthday.?®

Felony Adjudications (Vehicle Involved)

A one-year suspension of operating privileges is required when a juvenile has been adjudicated
delinquent for a felony offense and the court determines that a vehicle was essentially involved.?’

Vehicle Code Violations (non-Driving Under the Influence (DUI))

In Pennsylvania, a juvenile’s driving privilege may be suspended not only for DUI-related conduct, but
also for a defined set of non-DUI motor vehicle offenses that carry mandatory license suspensions under
the Vehicle Code. These suspensions are imposed either by statute upon conviction/adjudication or
administratively by the Pennsylvania Department of Transportation (PennDOT), regardless of whether the
driver is a minor or adult.

For youth under the age of 18, the impact of these offenses can be especially significant. In addition to
mandatory suspensions tied to specific offenses, minors are subject to lower thresholds under the point

24 The Common Application can be viewed at https://www.commonapp.org/.
2 See 42 Pa.C.S. § 6354(a).
26 See 75 Pa.C.S. § 1541(a).
27See 75 Pa.C.S. § 1532(a)(1).
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system, meaning that certain traffic violations can resultin loss of licensure earlier than for adult drivers.?®

The chart below identifies non-DUI offenses that require a suspension of operating privileges, including

the statutory citation, offense grading, mandatory suspension length, as well as applicable fines and
penalties. This list is limited to offenses where suspension is required by law (not discretionary) and

excludes DUl and underage DUI provisions.

Documents and
Plates

§ 1532(a)(3)

court

Mandatory .
Offense Statute Grade . Fine/Penalty Notes
Suspension
42 Pa.C.S. § 2154 includes
sentencing enhancements
) 75 Pa.C.S. . . for violations in an active
Homicide by Discretion of the N
) § 3732, F3 3years work zone or convictions
Vehicle court .
§1532(a.1)(1) under sections 1501, 1543,
3316, 3316.1, 3325, or
3327.
$1,000 and
minimum
. imprisonment not
Accidents 75 Pa.C.S.
. M1, F3, or less than 90 days, or
Involving Death or |8 3742, 1 year
. F2 $2,500 and
Personal Injury § 1532(a)(3) .
minimum
imprisonment not
less than 3 years
Accidents
Involving Death or | 75 Pa.C.S. . .
] M2, F3, or Discretion of the
Personal Injury §3742.1, 1 year
. M3 court
While Not § 1532(a)(3)
Properly Licensed
Dealing in Titles 75 Pa.C.S. . .
Discretion of the
and Plates for §7111, M1 1year ;
cour
Stolen Vehicles § 1532(a)(3)
False Application
o 75 Pa.C.S. . .
for Certificate of Discretion of the
] §7121, M1 1year
Title or court
i . § 1532(a)(3)
Registration
Altered, Forged,
] 75 Pa.C.S. . .
or Counterfeit Discretion of the
§7122, M1 1vyear

28 See 75 Pa.C.S. § 1535(e).
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Offense Statute Grade Mandatory Fine/Penalty Notes
Suspension
Fleeing or 12 months if
] 75 Pa.C.S. o
Attempting to adjudicated, 6 o
) § 3733, M2 or F3 $500 minimum
Elude Police months for
) §1532(b)(3)
Officer Consent Decree
N/A for first
) . 75 Pa.C.S. offense, 6
Drivers Required
i § 1501(a), Summary | months for $200
to be Licensed
§1532(a)(2) subsequent
violations
$500 for first
) offense, $2,000 for
Racing on 75 Pa.C.S.
. second offense or
Highways and § 3367, Summary |6 months . .
. imprisonment for no
Trafficways §1532(a)(1)
more than 6 months,
or both
. 75 Pa.C.S. 8 3714(b) and
$500 if causes ) ’
75Pa.C.S. § . (c) include sentencing
o death, $250 if
Careless Driving |3714, Summary |6 months . enhancements for
causes serious : . .
§1532(b)(1) . unintentional serious
bodily injury .
bodily injury or death.
Driving without
) . 75 Pa.C.S.
Lights to Avoid
. § 3734, Summary |6 months $200 Intent-based offense.
Identification or
§1532(b)(1)
Arrest
75 Pa.C.S.
. Mandatory upon PennDOT
Reckless Driving |8 3736, Summary |6 months $200 Ny
certification.
§1532(b)(1)
Accidents
) $2,500, or
Involving Damage |75 Pa.C.S. . .
imprisonment not
to Attended § 3743, M3 6 months
. more than 1 year, or
Vehicle or §1532(b)(1)
both
Property
6 months for first Includes public-school
o offense, 1 year grounds, school-
Terroristic Threats L
] 18 Pa.C.S. for second . . sponsored activity, or
(committed on or Discretion of the .
. § 2706, M1 or F3 |offense, or 2 transportation to school
against any court .
§1532(c) years for entity or school-sponsored
school property) L
subsequent activity.
violations
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Offense Statute Grade Mandatory Fine/Penalty Notes
Suspension
Operation
) 75 Pa.C.S.
Following Not less than $100,
. §1371, Summary |3 months
Suspension of no more than $500
. . § 1532(b)(4)

Registration
$200 minimum, $500|75 Pa.C.S. § 1543(b)

Driving While Additional 30 and 60 days includes sentencing

Operating days, 1year, or2 |imprisonment, enhancements for certain

o ) 75 Pa.C.S. Summary
Privilege is years for $1,000 and 90 days |offenses.
§1543(a) or M3 . .

Suspended or subsequent imprisonment, or

Revoked violations $2,500 and 6 months
imprisonment

DUI-Related and Drug-Related Offenses

Pennsylvania enforces strict DUl laws for individuals under age 21. The Commonwealth’s Zero
Tolerance Law prohibits minors from consuming alcohol. Any measurable amount of alcohol while
operating a motor vehicle can result in legal and administrative consequences.

Under Pennsylvania’s Zero Tolerance Law, an individual under age 21 commits a DUI offense if they
drive a motor vehicle with a blood alcohol concentration (BAC) of 0.02% or higher within two hours after
they have driven, operated, or been in actual physical control of the movement of the vehicle. This
threshold is significantly lower than the adult DUI standard and reflects Pennsylvania’s emphasis on
preventing underage drinking and impaired driving.

Depending on BAC level and circumstances, a minor may be charged under the following DUI tiers
established in Pennsylvania law:

e ZeroTolerance DUI (Under 21 years of age): BAC 0.02% or higher

e GeneralImpairment DUI (Over 21 years of age): BAC 0.08%-0.099%
¢ High Rate DUI (Over 21 years of age): BAC 0.10%-0.159%

e Highest Rate DUI (Over 21 years of age): BAC 0.16% or higher

Aggravating factors, such as involvement in a crash, injury, prior DUI history, or refusal of chemical
testing, may result in enhanced penalties.?® Enhanced penalties for juvenile drivers with a BAC of 0.02%
or higher may apply even with a BAC that does not meet the general impairment, high, or highest rate DUI
tier for individuals over 21 years of age.*

2 See 75 Pa.C.S. § 3802(e).
30 See 75 Pa.C.S. § 3804.
February 2026 Page 12
Juvenile Court Judges’ Commission
Pennsylvania Judicial Center | 601 Commonwealth Avenue, Suite 4600
P.O. Box 62425 | Harrisburg, PA 17106 | 717.787.6910 | F. 717.783.6266 | www.pa.gov/agencies/jcjc



https://www.pa.gov/agencies/jcjc
https://www.legis.state.pa.us/WU01/LI/LI/CT/HTM/75/00.038.002.000..HTM
https://www.legis.state.pa.us/WU01/LI/LI/CT/HTM/75/00.038.002.000..HTM
https://www.legis.state.pa.us/WU01/LI/LI/CT/HTM/75/00.038.002.000..HTM
https://www.legis.state.pa.us/WU01/LI/LI/CT/HTM/75/00.038.004.000..HTM

Juveniles who are adjudicated delinquent for driving under the influence of alcohol or controlled
substances are subject to suspension of motor vehicle operating privileges pursuantto 75 Pa.C.S. § 3804,
75 Pa.C.S. 8 1532, and Act 24 of 2003 as follows:

injury, death, or property damage.)

PENALTIES FOR GENERAL IMPAIRMENT BLOOD ALCOHOL CONCENTRATION
(Note: This table only applies to drivers involved in an accident that causes bodily injury, serious bodily

First Offense

Second Offense

Third Offense

and 1 year ignition
interlock requirement

Suspension

and 1 year ignition
interlock requirement

Penalty 6 months probation No less than 5 days No less than 10 days imprisonment
imprisonment

Fine $300 $300-$2,500 $500-$5,000

License 12 months suspension |12 months suspension 12 months suspension and 1 year

ignition interlock requirement

Attend alcohol highway
safety school and
comply with drug and
alcohol treatment

Enhanced
Penalties

Attend alcohol highway
safety school and comply
with drug and alcohol
treatment

Comply with drug and alcohol
treatment

injury, death, or property damage.)

PENALTIES FOR HIGH RATE BLOOD ALCOHOL CONCENTRATION
(Note: This table only applies to drivers involved in an accident that causes bodily injury, serious bodily

First Offense

Second Offense

Third Offense

and 1 year ignition
interlock requirement

Suspension

and 1 year ignition
interlock requirement

Penalty No less than 48 hours No less than 30 days No less than 90 days imprisonment
imprisonment imprisonment

Fine $500-$5,000 $750-$5,000 $1,500-$10,000

License 12 months suspension |12 months suspension 18 months suspension and 1 year

ignition interlock requirement

Attend alcohol highway
safety school and
comply with drug and
alcohol treatment

Enhanced
Penalties

Attend alcohol highway
safety school and comply
with drug and alcohol
treatment

Comply with drug and alcohol
treatment

PENALTIES FOR HIGHEST RATE BLOOD ALCOHOL CONCENTRATION
(Note: This table only applies to drivers who refuse chemical testing at Highest Rate BAC level and
drivers convicted of driving under the influence of Schedule I, Il, or lll substances that are not medically
prescribed, a combination of another drug and alcohol, or substances such as inhalants.)
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First Offense Second Offense Third Offense
Penalty No less than 72 hours No less than 90 days No less than 1 year imprisonment
imprisonment imprisonment
Fine $1,000 - $5,000 $1,500 minimum $2,500 minimum
License 12 months suspension |18 months suspension 18 months suspension and 1 year
Suspension|and 1 yearignition and 1 year ignition ignition interlock requirement
interlock requirement interlock requirement
Enhanced |Attend alcohol highway |Attend alcohol highway Comply with drug and alcohol
Penalties safety school and safety school and comply |treatment
comply with drug and with drug and alcohol
alcohol treatment treatment

School-related Offenses

A suspension of operating privileges is required for adjudications of delinquency relating to terroristic
threats committed on school property, including any public school grounds, during any school- sponsored
activity, or on any conveyance providing transportation to a school entity or school-sponsored activity. A
suspension for six months is required for a first offense, one year for a second offense, and two years for
third and subsequent offenses.?’

Truancy-related Dispositions

A suspension of operating privileges is required for juveniles who are convicted of violating the
compulsory attendance requirements of the Public School Code (24 P.S. § 13-1333). A suspension for 90
days is required for the first conviction and 6 months for a second conviction.?3?

Suspension of Operating Privileges at the Court’s Discretion

The court may order the PennDOT to suspend the operating privileges of a juvenile for any offense at
the court’s discretion.

Possession or Purchase of a Firearm

18 Pa.C.S. 8 6105 prohibits juveniles from possessing, using, manufacturing, controlling, selling, or
transferring firearms following an adjudication of delinquency for the following offenses:

e Section 908 (relating to prohibited offensive weapons).
e Section 911 (relating to corrupt organizations).

e Section 912 (relating to possession of weapon on school property).

31See 75 Pa.C.S. § 1532(c)(1).
52See 24 P.S. § 13-1333.3.
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Section 2502 (relating to murder).
Section 2503 (relating to voluntary manslaughter).

Section 2504 (relating to involuntary manslaughter) if the offense is based on the reckless use of a
firearm.

Section 2702 (relating to aggravated assault).

Section 2703 (relating to assault by prisoner).

Section 2704 (relating to assault by life prisoner).
Section 2709.1 (relating to stalking).

Section 2716 (relating to weapons of mass destruction).
Section 2901 (relating to kidnapping).

Section 2902 (relating to unlawful restraint).

Section 2910 (relating to luring a child into a motor vehicle or structure).
Section 3121 (relating to rape).

Section 3123 (relating to IDSI).

Section 3125 (relating to aggravated indecent assault).
Section 3301 (relating to arson and related offenses).
Section 3302 (relating to causing or risking catastrophe).
Section 3502 (relating to burglary).

Section 3503 (relating to criminal trespass) if the offense is graded a felony of the second degree or
higher.

Section 3701 (relating to robbery).
Section 3702 (relating to robbery of motor vehicle).

Section 3921 (relating to theft by unlawful taking or disposition) upon conviction of the second
felony offense.

Section 3923 (relating to theft by extortion) when the offense is accompanied by threats of violence.

Section 3925 (relating to receiving stolen property) upon conviction of the second felony offense.
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e Section 4906 (relating to false reports to law enforcement authorities) if the fictitious report
involved the theft of a firearm as provided in section 4906(c)(2).

e Section 4912 (relating to impersonating a public servant) if the person is impersonating a law
enforcement officer.

e Section 4952 (relating to intimidation of withesses or victims).

e Section 4953 (relating to retaliation against witness, victim or party).
e Section 5121 (relating to escape).

e Section 5122 (relating to weapons or implements for escape).

e Section 5501(3) (relating to riot).

e Section 5515 (relating to prohibiting of paramilitary training).

e Section 5516 (relating to facsimile weapons of mass destruction).

e Section 6110.1 (relating to possession of firearm by minor).

e Section 6301 (relating to corruption of minors).

e Section 6302 (relating to sale or lease of weapons and explosives).

e Any offense equivalent to any of the above-enumerated offenses under the prior laws of this
Commonwealth or any offense equivalent to any of the above-enumerated offenses under the
statutes of any other state or of the United States.??

It should be noted that this prohibition also applies to persons who have been involuntarily committed
for mental health treatment under sections 302, 303, or 304 of the Mental Health Procedures Act, and to
persons who are the subject of an active protection from abuse orderissued pursuantto 23 Pa.C.S. 86108,
when the order provided for the relinquishment of firearms.3*

The Pennsylvania State Police (PSP) maintains a registry of juveniles who have been adjudicated
delinquent for the offenses enumerated in 18 Pa.C.S. § 6105. However, the contents of the law
enforcementrecords concerning juveniles are not to be disclosed in conjunction with a firearms purchase
background check, unless the juvenile was 14 years of age or older at the time of the alleged offense and
the juvenile:

* has been adjudicated delinquent on the basis of an offense enumerated in 18 Pa.C.S. 8 6105; or

e apetition alleging delinquency has been filed alleging that the juvenile has committed any offense

33 See 18 Pa.C.S. § 6105.
34 See 18 Pa.C.S. § 6105(c)(4), and 18 Pa.C.S. § 6105(a)(2)(iv).
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enumerated in 18 Pa.C.S. § 6105, and the juvenile had been previously adjudicated delinquent by
a court as a result of an act or acts which included the elements of any one of these crimes.*

It should be noted that it has been the PSP policy to classify an adjudication of delinquency related to
adrug-related offense within the pastyear as a conviction under federalinterpretation of an “unlawful user
of oraddicted to any controlled substance.” Accordingly, a person may be an “unlawful user of or addicted
to any controlled substance” based on evidence of a recent use or possession of a controlled substance,
or a pattern of use or possession that reasonably covers the present time (e.g., a person who is convicted
for use or possession of a controlled substance within the past year; multiple arrests for such offenses
within the past five years if the most recent arrest occurred within the past year). *

The prohibition related to the possession, use, manufacture, control, sale, or transfer of firearms
terminates 15 years after the date of the last applicable adjudication of delinquency, or at age 30,
whichever comes first, depending on the offense for which the juvenile was adjudicated delinquent.®’

Use of Delinquency Adjudications for Criminal Sentencing Purposes

While adjudications of delinquency can be included in presentence investigations and considered by
the court in framing a sentence following a criminal conviction, only certain adjudications of delinquency
are counted when calculating the prior record score, pursuant to the Sentencing Guidelines developed by
the Pennsylvania Commission on Sentencing.3® Adjudications of delinquency are counted in the prior
record score if the offense occurred on or after the juvenile’s 14" birthday, and if there was an express
finding by the court that the adjudication related to a felony or one of the Misdemeanor 1 offenses
enumerated in 204 Pa. Code § 303.7(a)(4).

The following is an excerpt from 204 Pa. Code 8 303.7 (relating to prior record score-guideline points
scoring):

a. §8303.7(a)(1) — Four points are added for each prior adjudication of delinquency for the following
offenses:

e Murder, and attempt, solicitation, or conspiracy to commit Murder.
e Allother completed crimes of violence, as defined in 42 Pa.C.S. 8§ 9714(g), excluding inchoates.

e Murder of Unborn Child, and attempt, solicitation, or conspiracy to commit Murder of Unborn
Child.

e Offenses with an Offense Gravity Score (OGS) of 11 or greater, excluding inchoates and

35See 18 Pa.C.S. §6111.1(h).
% See 27 CFR §478.11.
37 See 18 Pa.C.S. § 6105(c)(8).
38 See 204 Pa. Code § 303.6.
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violations of the Controlled Substance Act.
e Ethnic Intimidation to any Felony 1 offense.

b. § 303.7(a)(2) — Three points are added for each prior adjudication of delinquency for Felony 1
offenses not listed in 8 303.7(a)(1), inchoates to offenses listed in § 303.7(a)(1), sexual assault,
aggravated indecent assault, and violations of 35 P.S. § 780-113 (relating to prohibited acts;
penalties).

c. 8§8303.7(a)(3)-Two points are added for each adjudication of delinquency for Felony 2 offenses not
listedin§303.7(a)(1) or 8303.7(a)(2), and all felony drug offenses not listed in 8 303.7(a)(2) including
inchoates.

d. 8 303.7 a)(4) - One point is added for each adjudication of delinquency for felonies not listed in §
303.7(a)(1), (a)(2), or (a)(3), and for Misdemeanor 1 offenses that involve weapons or involve death
or danger to children, and for driving under the influence of alcohol or controlled substance when
the grade is a misdemeanor.

e. 8§ 303.7(a)(b5) — All other misdemeanor offenses designated by an “m” in the offense listing at §
303.15. Points added depend on the number of previous convictions.

Lapsing of Juvenile Adjudications

Prior juvenile adjudications for four point offenses listed in 8 303.7(a)(1) are always included in the prior
record score. All other adjudications lapse and are not counted in the prior record score if the offender
was 28 years of age or older at the time of the commission of the offense for which the offender is being
sentenced and the offender remained crime-free during the ten-year period immediately preceding the
offender’s 28™ birthday. Included in the definition of “crime-free” is any summary offense and/or one
misdemeanor offense with a statutory maximum term of imprisonment of one year or less.*

Record Retention

The Pennsylvania Supreme Court’s Record Retention and Disposition Schedule with Guidelines
includes a schedule for juvenile delinquency and dependency records. The guidelines provide that, unless
expunged, the docket and original court orders are considered “permanent” records and may not be
destroyed unless replicated pursuant to the guidelines. All other records, including petitions, evaluations,
case supervision records, etc., are considered “non-permanent” records and, unless expunged, may not
be destroyed until the child reaches 25 years of age or ten years after the date of the last action, whichever
is later.%°

The Pa.R.J.C.P. indicate the juvenile court file is the official court record and shall contain all court

3% See 204 Pa. Code § 303.6(c).
40 See 204 Pa. Code § 213.51.
February 2026 Page 18
Juvenile Court Judges’ Commission
Pennsylvania Judicial Center | 601 Commonwealth Avenue, Suite 4600
P.O. Box 62425 | Harrisburg, PA 17106 | 717.787.6910 | F. 717.783.6266 | www.pa.gov/agencies/jcjc



https://www.pa.gov/agencies/jcjc
https://www.pacourts.us/Storage/media/pdfs/20210225/033858-recordretentionsched-000173.pdf
https://www.pacodeandbulletin.gov/Display/pacode?file=/secure/pacode/data/204/chapter303/s303.6.html&d=
https://www.pacodeandbulletin.gov/Display/pacode?file=/secure/pacode/data/204/chapter213/subchapBtoc.html&d=reduce

orders, court notices, docket entries, filed documents, evidence admitted into the record, and other court
designated documents in each juvenile case. These records shall be maintained by the clerk of courts and
shall not be taken from the custody of the clerk of courts without order of the court.*'

41 See Pa.R.J.C.P. 166.
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LAW ENFORCEMENT RECORDS

The Juvenile Act sets forth provisions regarding the inspection and dissemination of law enforcement
records. Law enforcement files and records of juveniles must be kept separate from the files and records
of adults, and inspection of the files and records is permitted by only the following:

e the court having the child before it in any proceeding;
e counselfor a party to the proceeding;
¢ the officers of institutions or agencies to whom the child is committed;

¢ law enforcement officers of other jurisdictions when necessary for the discharge of their official
duties; and

e a court in which the juvenile is convicted of a criminal offense for the purpose of a presentence
report or other dispositional proceeding, or by officials of penal institutions and other penal
facilities to which a juvenile is committed, or by a parole board in considering parole or discharge,
or in exercising supervision over the child.

e the Pennsylvania Department of Public Welfare (now referred to as Department of Human Services
or DHS) for the use in determining whether an individual named as the perpetrator of an indicated
report of child abuse should be expunged from the statewide database.*?

Definitions

2 13

The terms “Central Repository”, “Criminal History Record Information”, and “Juvenile History Record
Information” as follows:

Central Repository is the central location for the collection, compilation, maintenance and
dissemination of criminal history record information by the PSP.*3

Criminal History Record Information refers to information collected by criminal justice agencies
concerning individuals, and arising from the initiation of a criminal proceeding, consisting of
identifiable descriptions, dates and notations of arrests, indictments, information or other formal
criminal charges and any dispositions arising therefrom. The term does not include intelligence

information, investigative information or treatment information, including medical and psychological
information, or information and records specified in 18 Pa.C.S. § 9104 (relating to scope).*

¢ |n addition to the definition in 18 Pa.C.S. § 9102 (relating to definitions), the term includes the

42See 42 Pa.C.S. §6308.
43See 18 Pa.C.S.§9102
44 See 18 Pa.C.S. §9102.
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definition of “Juvenile History Record Information” as defined in 42 Pa.C.S. § 6309(e) and included
below.

Juvenile History Record Information refers to information collected pursuant to this section concerning
alleged delinquents and adjudicated delinquents whose fingerprints and photographs are taken
pursuant to section 6308(c) and arising from an allegation of delinquency, consisting of identifiable
descriptions, dates and notations of arrests or other delinquency charges and any adjudication of
delinquency or pre-adjudication disposition other than dismissal arising therefrom. This information

shall also include the last known location and the juvenile court jurisdiction status of each adjudicated
delinquent. Juvenile history record information shall not include intelligence information, investigative
information, treatment information, including medical and psychiatric information, caution indicator
information, modus operandi information, wanted persons information, stolen property information,
missing persons information, employment history information, personal history information or
presentence investigation information.*

Public Availability

The contents of law enforcement records and files concerning a juvenile shall not be disclosed to the
public unless applicable under 42 Pa.C.S. § 6308. If the juvenile’s conduct meets the public availability
criteria, the law enforcement agency shall disclose the juvenile’s name, age, address, the offenses
charged, and the disposition of the case.*®

Fingerprints and Photographs

The Juvenile Act sets forth provisions regarding the taking and dissemination of fingerprints and
photographs. Law enforcement officers are allowed to take fingerprints and/or photographs of a juvenile
who is alleged to have committed a misdemeanor or felony offense under state, federal, or another state’s
laws. If the juvenile is adjudicated delinquent or the case is transferred for criminal prosecution, the
responsible law enforcement agency must ensure the juvenile’s fingerprints and photographs are taken
and submitted to the PSP Central Repository. If a juvenile was alleged to be delinquent by an entity other
than a law enforcement agency, the court must direct the juvenile probation office to ensure that the
fingerprints and photographs are taken by a law enforcement agency.*’ In situations where fingerprints
and photographs have been taken, and it is subsequently determined that the juvenile did not commit the
alleged offenses, the court must direct that the records be destroyed immediately.*®

Al fingerprints and photographs of juveniles must be kept separate from adult fingerprints and
photographs.*® Fingerprint and photograph records may be disseminated to law enforcement officers of

45 See 42 Pa.C.S. § 6309(e)
46 See 42 Pa.C.S. § 6308(b)
47 See 42 Pa.C.S. § 6308(c)
(c)
(c)

48 See 42 Pa.C.S. §6308(c
4 See 42 Pa.C.S. §6308(c
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other jurisdictions, the PSP, and the Federal Bureau of Investigation (FBI), and may be used for
investigative purposes.®

Juvenile History Record Information

Juvenile history record information in Pennsylvania is governed largely by the Criminal History Record

Information Act (CHRIA)." The Juvenile Act sets forth the provisions of juvenile history record information
regarding alleged and adjudicated delinquent youth and requires the PSP to maintain a central repository
of juvenile fingerprints, photographs, and case dispositions, and mandates the timely submission of
fingerprints and court outcomes by arresting authorities and juvenile courts. The Juvenile Act also
restricts public access through separate confidentiality provisions and defines juvenile history record
information narrowly, limiting it to identifying information and case disposition data, while expressly
excluding investigative materials, intelligence information, treatment records, and other sensitive
personal data.*?

50 See 42 Pa.C.S. § 6308(c)(2).
51See 42 Pa.C.S.§6309 and 18 Pa.C.S.§9101.
52See 42 Pa.C.S. § 6309.
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DNA SAMPLES

44 Pa.C.S. 8 2300 serves to establish, maintain, and regulate DNA collection in Pennsylvania, and
authorizes the PSP to use DNA analysis for investigative purposes in certain cases. Under Pennsylvania
law certain offenses require the collection of DNA samples.

Definitions

44 Pa.C.S. 8 2303 defines the terms “CODIS”, “DNA Record”, “DNA Sample”, “Felony Sex Offense”,
“Forensic DNA Laboratory”, “Forensic DNA Profile”, “Forensic DNA Testing”, and “Other Specified
Offense” as follows:

CODIS is the Combined DNA Index System established and maintained by the FBI.

DNA Record refers to a forensic DNA profile and identification information stored in the State DNA
Database or CODIS for the purpose of identification or supporting statistical interpretation of DNA test

results.
DNA Sample refers to a sample of biological material suitable for forensic DNA testing.

Felony Sex Offense is a felony offense or an attempt, conspiracy or solicitation to commit a felony

offense, under any of the following:
e 18 Pa.C.S. Chapter 31 (relating to sexual offenses).
e 18Pa.C.S. 84302 (relating to incest).
e 18Pa.C.S. 85902(c)(1)(iii) and (iv) (relating to prostitution and related offenses).

e 18Pa.C.S. 8§5903(a) (relating to obscene and other sexual materials and performances) where
the offense constitutes a felony.

e Any offense graded as a felony requiring registration under 42 Pa.C.S. Chapter 97 Subchapter H
(relating to registration of sexual offenders).

Forensic DNA Laboratory is a laboratory that performs forensic DNA testing for the purposes of
identification.

Forensic DNA Profile refers to the data set derived from forensic DNA testing.

Forensic DNA Testing refers to a test that applies techniques from molecular biology to analyze DNA
to identify data which meets the requirements for inclusion in CODIS and the National DNA Identification
Index System (NDIS) administered by the FBI.
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Other Specified Offense includes a felony that is not a felony sex offense, an offense the Pennsylvania
Crimes Code (18 Pa.C.S.) orVehicle Code (75 Pa.C.S.) that is graded as a misdemeanor of the first degree,
a misdemeanor offense that requires registration under 42 Pa.C.S. Chapter 97, Subchapter H (relating to
registration of sexual offenders), or an offense graded as a misdemeanor of the second degree under any
of the following:

e 18Pa.C.S. §2701 (relating to simple assault).

e 18Pa.C.S. § 2903 (relating to false imprisonment).

e 18Pa.C.S. § 3127 (relating to indecent exposure).

e 18 Pa.C.S. Ch. 39 (relating to theft and related offenses).

e 18Pa.C.S. 84105 (relating to bad checks).

e 18Pa.C.S. 84106 (relating to access device fraud).

e 18Pa.C.S. 84952 (relating to intimidation of witnesses or victims).

e 18Pa.C.S. § 4953 (relating to retaliation against witness, victim or party).

e 18Pa.C.S. § 4958 (relating to intimidation, retaliation or obstruction in child abuse cases).
e 18Pa.C.S. 85121 (relating to escape).

e 18Pa.C.S. 85126 (relating to flight to avoid apprehension, trial or punishment).
e 18Pa.C.S. 85131 (relating to recruiting criminal gang members).

e 18Pa.C.S. 85510 (relating to abuse of corpse).

e 18Pa.C.S. Ch. 55 Subch. B (relating to cruelty to animals).

e 18Pa.C.S. 85902 (relating to prostitution and related offenses).
DNA Collection

The PSP are responsible for the policy management and administration of the Pennsylvania State DNA
Identification Record System (SDIS), as well as storing and maintaining forensic DNA profiles and records
in the State DNA Database and DNA samples in the State DNA Databank.®

Juveniles adjudicated delinquent for a felony sex offense or other specified offense as defined in 44
Pa.C.S. § 2303 must submit a DNA sample to the PSP for inclusion in the State DNA Database and State

53 See 44 Pa.C.S. §§ 2311(1)-2313.
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DNA Databank.® DNA samples must be submitted to the PSP within 48 hours of collection.®® It is
recommended that, in intercounty transfer cases, the court which adjudicates a juvenile delinquent
should ensure that the DNA sample is drawn.

Unless the court finds that undue hardship would result, a mandatory $250 cost assessment is
automatically imposed on any person convicted, adjudicated delinquent, or granted Accelerated
Rehabilitative Disposition (ARD) for a felony sex offense or other specified offense.®®

54See 44 Pa.C.S. § 2316.
% See 37 Pa. Code § 58.21(h)
56 See 44 Pa.C.S. § 2322
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EXPUNGEMENT OF JUVENILE RECORDS

Definitions

The terms “Destroy” and “Expunge” have been defined in the Pa.R.J.C.P. as follows:

Destroy or Destruction is to erase permanently or the process of permanent erasure of an item leaving
no trace or indication that it ever existed.

Expunge or Expungement is to erase legally or the process of legal erasure of the juvenile record or
the sealing of the record making it permanently unavailable to the public but where some information

may be retained only by a juvenile justice agency for limited purposes as provided in Pa.R.J.C.P. 173.%

Although they are often used interchangeably, the terms “Destroy” and “Expunge” do not have the
same meaning. “Destroy” is to erase permanently, whereas “Expunge” is to erase legally or seal the
record. Unless authorized by rule or otherwise provided by law, no person is to have access to expunged
items. Only in extraordinary circumstances would a record be opened by a court order, such as to retrieve
specific information not clarified or documented correctly. However, specific information from juvenile
records could be retained for limited purposes.®®

The CHRIA, which applies to alleged and adjudicated delinquents whose fingerprints and
photographs are taken, and to any juvenile justice agency which collects, maintains, disseminates or
receives juvenile history record information, defines the term “Expunge” as follows:

e toremove information so there is no trace or indication that such information existed;

e to eliminate all identifiers which may be used to trace the identity of an individual, allowing
remaining data to be used for statistical purposes; or

e maintenance of certain information required or authorized under the provisions of 18 Pa.C.S. §
9122(c) (relating to expungement), when an individual has successfully completed the conditions
of any pretrial or post-trial diversion or probation program.®®

Requirements for the Expungement of Juvenile Records

18 Pa.C.S. § 9123 sets forth requirements for the expungement of juvenile records. Except upon cause
shown, expungement of records of juvenile cases, wherever kept or retained, shall occur after 30 days’
notice to the District Attorney (DA), whenever the court upon its motion or upon the motion of a child or

57 See Pa.R.J.C.P. 120.
%8 See Comment to Pa.R.J.C.P. 173.
% See 42 Pa.C.S. § 6309 and 18 Pa.C.S. § 9102.
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the parents or guardian finds:

1. acomplaintisfiled whichis not substantiated or the petition which s filed as a result of a complaint
is dismissed by the court;

(1.1) a written allegation is filed which was not approved for prosecution;

(1.2) six months have elapsed since the individual successfully completed an informal adjustment
and no proceeding seeking adjudication or conviction is pending;

2. six months have elapsed since the final discharge of the person from supervision under a consent
decree or diversion program, including a program under 42 Pa.C.S. § 1520 (relating to adjudication
alternative program) and no proceeding seeking adjudication or conviction is pending;

(2.1) the individual is 18 years of age or older and six months have elapsed since the individual has
satisfied all terms and conditions of the sentence imposed following a conviction for a
summary offense, with the exception of a violation of section 6308 (relating to purchase,
consumption, possession or transportation of liquor or malt or brewed beverages),
committed while the individual was under 18 years of age and, since satisfying all terms and
conditions of the sentence, the individual has not been convicted of a felony, misdemeanor
or adjudicated delinquent and no proceeding is pending to seek such conviction and
adjudication;

(2.2) the individual is 18 years of age or older and has been convicted of a violation of section 6308
which occurred while the individual was under 18 years of age and six months have elapsed
since the individual has satisfied all terms and conditions of the sentence imposed for the
violation, including any suspension of operating privileges imposed under section 6310.4
(relating to restriction of operating privileges). Expungement shall include all criminal history
record information and all administrative records of the Department of Transportation relating
to the conviction;

3. two years have elapsed since the final discharge of the person from commitment, placement,
probation or any other disposition and referral, pursuant to an adjudication of delinquency
following a determination by the court that the person committed an offense classified as a
misdemeanor, other than a misdemeanor under Chapter 61 (relating to firearms and other
dangerous articles) or a misdemeanor under section 3126(a)(2) or (3) (relating to indecent assault),
and since such final discharge, the person has not been convicted of a felony, misdemeanor or
adjudicated delinquent and no proceeding is pending seeking such conviction or adjudication;

(3.1) five years have elapsed since the final discharge of the person from commitment, placement,
probation or any other disposition and referral, pursuant to an adjudication of delinquency
following a determination by the court that the person committed an offense classified as a
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felony, an offense classified as a misdemeanor under section 3126(a)(2) or (3), and since the
final discharge, the person has not been convicted of a felony, misdemeanor or adjudicated
delinquent and no proceeding is pending seeking the conviction or adjudication; or

4. the attorney for the Commonwealth consents to the expungement and a court orders the
expungement after giving consideration to the following factors:

i. the type of offense;

ii. the individual’s age, history of employment, criminal activity and drug or alcohol problems;
iii. adverse consequences that the individual may suffer if the records are not expunged; and
iv. whether retention of the record is required for purposes of protection of the public safety.

Prior to filing a motion to expunge a record, a request should be made to the PSP for the information
contained in the PSP Central Repository, commonly known as the rap sheet. This information can then be
compared with the information contained in the juvenile court file to ensure that the information in the PSP
Central Repository is consistent with the information to be included in the motion for expungement.

In counties where the juvenile probation office initiates the expungement process, a copy of the
juvenile’s criminal history record contained in the PSP Central Repository can be obtained by using the
application Pennsylvania Justice Network (JNET) Commonwealth Law Enforcement Assistance Network
(CLEAN) through the county’s JNET connection.

Expungement Process

Pa.R.J.C.P. 170(B) provides that juvenile records may be expunged upon motion, which shallinclude a
proposed court order, and contain the following information:

1. the name of the juvenile;

2. the date of birth (DOB) of the juvenile, if known;

3. thejuvenile’s case docket number, if any;

4. the allegations or offenses to which the order pertains;

5. the law enforcement agency that initiated the allegations;

6. the reference number of the police report or written allegation to be expunged or destroyed,
including the juvenile offense tracking number (JOTN), if available;

7. the date of arrest;

8. the disposition of the written allegation or petition;
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9. the reasons and statutory authority for expunging or destroying the document, fingerprints, or
photographs; and

10. the agencies upon which certified copies of the court order shall be served.

The motion is to be filed pursuant to Pa.R.J.C.P. 345 and must also be served upon the chief juvenile
probation officer. The attorney for the Commonwealth, and any other person upon whom the motion was
served, may file an answer to the motion. Unless the attorney for the Commonwealth consents to
expunging the record, the court must schedule and conduct a hearing and thereafter grant or deny the
motion.

Under 18 Pa.C.S. 8§ 9123 a motion for expungement may be filed by the court, the juvenile, or the
juvenile’s parent/guardian. In cases where an expungement could be granted if a juvenile were to request
it, itisrecommended that courts setin place procedures under which the juvenile probation office initiates
the expungement process automatically after the appropriate length of time has elapsed.®® This would
alleviate the need for the person who is the subject of records to be expunged to retain legal counsel to
initiate the process.

The chart below identifies the eligibility timeframes for expungement processing based on Act 108 of
2024, including the case outcome, triggering event, expungement timeline, required conditions,
initiating/notifying party, and statutory authority.

. . . Initiating/
Case Triggering Expungement Required Notifying Statutory
Outcome Event Timeline Conditions Authority
Party
Allegation Not | Allegation not | Immediate No pending ChiefJPOor | 42Pa.C.S.
Approved approved for adjudication or | designee §6304(a.2)(1)(i);
prosecution conviction notifies court | 18 Pa.C.S.§9123
Finding: Court finds Immediate N/A Court orders | 42 Pa.C.S.
Allegations acts not destruction §6341(a);
Not Proven committed by and 18 Pa.C.S5.89123
child expungement
Finding: Notin | Court Immediate N/A Court 42 Pa.C.S.
Need of dismisses commences | 8§6341(b);
Treatment, after expungement | 18 Pa.C.S. §9123
Supervision, or | adjudicatory
Rehabilitation | finding

80 See Pennsylvania Juvenile Delinquency Benchbook, 4-4.
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Case Triggering Expungement Required Initiating/ Statutory
Outcome Event Timeline Conditions Notifying Authority
Party
Petition Court Immediate No pending ChiefJPOor | 42Pa.C.S.
Dismissed/ dismisses/ adjudication or | designee §6304(a.2)(1)(ii);
Withdrawn withdraws conviction notifies court | 18 Pa.C.S. 89123
petition
Petition Court Immediate No pending Chief JPO or | 42 Pa.C.S.
Dismissed/ dismisses/ adjudication or | designee §6304(a.2)(1)(ii);
Withdrawn withdraws conviction notifies court | 18 Pa.C.S. 89123
petition
Informal Successful 6 months after | No proceeding | ChiefJPOor | 42Pa.C.S.
Adjustment completion of | discharge seeking designee §6304(a.2)(1)(iii),
Informal adjudication or | notifies §6323(g);
Adjustment conviction court; court 18 Pa.C.S.89123
supervision pending may act sua
sponte
Consent Successful 6 months after | No proceeding | ChiefJPOor | 42Pa.C.S.
Decree discharge from | discharge seeking designee §6304(a.2)(1)(iv),
Consent adjudication or | notifies § 6340(f);
Decree conviction court; court 18 Pa.C.S.89123
supervision pending may act sua
sponte
Adjudication - | Final 2 years after No new felony, | ChiefJPOor | 18Pa.C.S.
Misdemeanor | discharge from | final misdemeanor, | designee §9123(a)(3);
(Non- probation, discharge or delinquency | notifies court | 42 Pa.C.S.
Firearms/Non- | placement, or adjudication; §6304(a.2)(1)(v),
Sexual) other no pending §6352(d)(1)
disposition proceeding
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Case Triggering Expungement Required Initiating/ Statutory
Outcome Event Timeline Conditions Notifying Authority
Party
Adjudication- | Final 5years after No new felony, | ChiefJPOor | 18Pa.C.S.
Felony, discharge from | final misdemeanor, | designee §9123(a)(3.1);
Firearms disposition discharge or delinquency | notifies court | 42 Pa.C.S.
Misdemeanor adjudication; §6304(a.2)(1)(vi),
(Ch.61), or no pending §6352(d)(2)
Indecent proceeding;
Assault (18 offense not
§3126(a)(2)/(3) precluded
under 18
Pa.C.S.
§9123(a.1)

Expungement Orders

Pa.R.J.C.P. 172 requires that any order to expunge or destroy the juvenile court file, docket entries, law

enforcement records, or fingerprints and photographs is required to include the following information:

e allitems contained in Pa.R.J.C.P 170(B);

e adirective specifically identifying which items shall be expunged or destroyed, including all law
enforcement records, juvenile probation files, official court records, other juvenile records,

fingerprints, photographs, and any other information pertaining to the arrest;

o the court is to list specifically which items are to be expunged and which items are to be
destroyed. Specific information retained pursuant to Pa.R.J.C.P. 173 should be expunged but
not destroyed. In most instances, the court should order that the fingerprints and photographs

be destroyed and that the remaining records and documents be expunged.®’

e adirective that the keeper of the juvenile records shall expunge or destroy such items;

e a directive that each agency, department, or office, upon request, shall notify the court or its

designee, in writing, of the action taken in response to the order to expunge or destroy;

0 anagency, department, or office may be requested to produce evidence of compliance with the

61 See Comment to Pa.R.J.C.P. 172(A)(2).
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court order to expunge. Non-compliance may result in a finding of contempt of court.®?

e adirective to a school building principal or his or her designee to destroy information received from
the court pursuant to Pa. R.J.C.P 163;

o the schoolisto destroy all information received from the court. Because the school is required
to store this information separately under Pa.R.J.C.P. 163(F), destruction should not be
difficult.®® The court may also require the school to provide written notice of the action taken.®

* the printed name and signature of the judge issuing the order; and

e the date of the court order.
Distribution of Expungement Orders

In addition to service required by Pa.R.J.C.P. 167, the clerk of courts, court administrator, or other court
designee shall serve certified copies of the order on the chief juvenile probation officer, the PSP, the JCJC,
and any other person or agency as directed by the court.

As previously mentioned, the JCJC Standards Governing the Release of Information Contained in
Juvenile Court Files and Juvenile Probation Records and Reports recommend that a case-specific written
record be maintained by the juvenile probation office listing the names and addresses of individuals to
whom copies of records were provided. Copies of the expungement order must be directed to any
individual or agency having possession of juvenile court records.®®

Expungements of Intercounty Transfer of Delinquency Cases

¢ A motion to expunge or destroy records shall be filed in the county in which the adjudication of
delinquency was entered.

* A motion regarding the records of a juvenile whose disposition did not involve an adjudication of
delinquency should be filed in the county in which the disposition occurred.

e The court entering an order to expunge or destroy records should direct the order to any other court
possessing records pertaining to the case.

o Itis suggested that the attorney for the Commonwealth of the county in which the motion was
filed in an intercounty transfer case should provide notice to, and communicate with, the
attorney for the Commonwealth and the juvenile probation office in the county to which, or from

52 See Comment to Pa.R.J.C.P. 172(A)(4).
83 See Pa.R.J.C.P. 163 and Comment
64 See Comment to Pa.R.J.C.P. 172(A)(5).
8 See 37 Pa. Code § 200.802(c)(2).
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which, the case was transferred.®®
Expungement of DNA Records

DNA samples may be expunged on the grounds that the adjudication of delinquency was reversed and
the case dismissed and no appeal is pending, or that the DNA sample was included in the database by
mistake. Expungement orders must include all essential case-specific information required by the PSP to
accurately identify the records to be expunged. Court orders directing the expungement of DNA records
should also specifically instruct the PSP to notify the court, the juvenile, and the juvenile’s attorney of
record of the action taken in response to the order within 60 days.®’

Expungement of Pennsylvania Department of Transportation (PennDOT) Records

It has generally been the policy of PennDOT that expungement orders entered by courts do not apply
to driver history records maintained by PennDOT, unless there is a specific statutory provision which
allows a court to direct PennDOT to expunge a driver history record. For example, 18 Pa.C.S. 8 9122(a)(3)
(relating to expungement), requires the court to order the expungement of all criminal history record
information and all administrative records of PennDOT pertaining to a conviction or adjudication of
delinquency of 18 Pa.C.S. § 6308 (relating to purchase, consumption, possession or transportation of
liguor or malt or brewed beverages), provided the person is at least 21 years of age and has satisfied all
terms and conditions of the sentence imposed for the violation, including any suspension of operating
privileges. However, PennDOT does not regard other provisions of the CHRIA, including the provisions of
18 Pa.C.S. 8 9123 (relating to juvenile records), as empowering courts to order the expungement of driver
history information in conjunction with an order directing the expungement of juvenile court records or law
enforcement records.

% See Pa.R.J.C.P. 170(F).
5 See 44 Pa.C.S. § 2321.
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PENNSYLVANIA JUVENILE CASE MANAGEMENT SYSTEM (PaJCMS)

PaJCMS Expungement Eligibility Dashboard

The PalJCMS Expungement Eligibility Dashboard was developed in response to statutory changes
enacted through Act 108 of 2024, which amended Pennsylvania law to strengthen and clarify expungement
procedures for juvenile records. Act 108 established enhanced notification and review requirements,
placing greater responsibility on juvenile probation offices and CJPOs to identify eligible cases and initiate
the expungement process within prescribed timeframes.

Historically, expungement review in many counties relied on manual case tracking and individual staff
knowledge. This approach created variability across counties and increased the risk that expungement-
eligible youth might not receive timely notification or review. As expungement provisions expanded and
timelines became more structured under Act 108, the need for a consistent, data-driven mechanism
became clear.

The PaJCMS Expungement Eligibility Dashboard was created as a statewide management tool to assist
juvenile probation offices and designated staff in systematically identifying records that may qualify for
expungement, tracking notification requirements, and documenting review status. While the dashboard
does not replace judicial authority or the formal expungement process, it serves as an administrative
support system designed to promote compliance, transparency, and uniform implementation of statutory
requirements across counties.

The PaJCMS Expungement Eligibility Dashboard allows users to search for expungement-eligible cases
by date. Users are also able to toggle the search criteria between cases that are eligible and those that
were reviewed and became ineligible. Although this dashboard pulls cases that it deems as potentially
eligible for expungement based on built-in eligibility calculations and rules, all cases should be researched
and reviewed for eligibility before being expunged.

The dashboard identifies juveniles who may be eligible for expungement; however, the expungement
process itself is not completed through the dashboard. The dashboard serves as a working tool to assist
in identifying records that may qualify for expungement but is not required to process an expungement. If
a record has already been approved for expungement, the case may be processed without updating
dashboard status fields. Regardless, a thorough review is required to confirm that no legal or procedural
reasons exist for the record to remain.

Disclaimer: The PaJCMS Expungement Eligibility Dashboard is to be used as a tool and guide for
expunging juvenile records but does not preclude the juvenile probation office from needing to research
more information before making the decision to expunge. The dashboard identifies expungement eligibility
based solely on records within the county using the system. If a juvenile has involvement in another
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Pennsylvania county at the juvenile or adult level, the “Related Records” function within the dashboard
may identify those cases. Any related records must be independently reviewed and researched before a
final expungement eligibility determination is made.

PaJCMS Reports
e Allegations Expunged During a Time Period

o This report summarizes the number of allegations/cases that have been expunged in the
selected date range by year and month.

e (Cases Eligible for Expungement by Eligibility Date and Type

o This report identifies all cases that became eligible for expungement consideration in the
selected date range. For the purposes of this report, the case is identified as “eligible for
expungement” because it has met the criteria as pursuant to the Pa.R.J.C.P. Before expunging
this record, the end user is encouraged to review CPCMS for any subsequent criminal
convictions or pending criminal proceedings in this same time period, as such would exclude
this case as eligible for expungement, pursuant to Pa.R.J.C.P. 170.%8

Expungement Data in PaJCMS

When a juvenile record is expunged, the information is suppressed from view but not permanently
deleted from the system. Expunged records continue to be included in aggregate data, such as annual
reports and statistical analyses. While the individual’s record is cleared, system data reflecting county
activity such as allegations, hearings, decisions, and placements, remains counted for reporting purposes.

68 See PaJCMS Expungement Report section on page 44 for screenshots of report.
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PaJCMS EXPUNGEMENT ELIGIBILITY DASHBOARD USER GUIDE

The PaJCMS Expungement Eligibility Dashboard is a tool designed to help identify juvenile records that
may qualify for expungement. It allows users to search for eligible cases by date and to filter cases based
on eligibility status. The dashboard does not replace the responsibility of the juvenile probation office to
conduct a thorough review of all cases to ensure statutory expungement criteria are satisfied before any

record is expunged.

The steps below outline how to access and use the dashboard in PaJCMS:

1. Accessing the dashboard

From the main navigation bar atthe top of the PaJCMS screen, clickthe Admin Tools tab, then select
“Expungement Eligibility” from the drop-down menu.

Pennsylvania Juvenile Case Managen i

v Victim v Users v Management Tools v Admin Tools
Global PO Change
LTM

I Juvenile [ Victim Security - User
Security - Group

Home v Actions

v Juvenile

Search

Address Search Advanced Search

Juvenile Explorer

Security - Reports
WatchList Mgmt

Juvenile First Name County JID YLS Approval
SSN ‘ v ‘ ALL PaDRAI Override Approvaliii¥

Juvenile Last Name

PO Unit PO Unit ASSiQHEd PO Session Info
Dashboard Assignment
Expungement Eligibility

Expungement Eligibility
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2. Searching by date

Use the date search fields to display cases that became eligible for expungement within the
selected timeframe. Eligible cases willappearinthe “Eligible Expungements List” above the search

dates.

Home « Juvenile - Actions - Victims « Users . Management Tools « Admin Tools

Eligible Expungement List:

Actions Juvenile ¥ Case Number ¥ Docket Number ¥  Eligibility Date ¥ Type T Status ¥ Qualifying Deposition ¥ Close Date ¥

View 01/02/2024 Ad]udncatlon Pendmg 011272017 ~
View 01/02/2024 Adjudication Pending 01/13/2018 ’]
View 11/05/2023 Adjudication Pending 01/03/2019 J
View 11/05/2013 Adjudication Pending 01/04/2018
View 01/02/2023 Adjudication Confirmed Eligible 01/07/2013
View 01/06/2023 Adjudication Submitted / under review 01/05/2018
View 01/06/2013 Adjudication awaiting 01/04/2014
View 01/16/2023 Adjudication Pending 09/10/2018

(02!23f2024 il 02/29/2024 '7" Eligibility Status ® Review Eligible O Post-Review: Ineligible O Post-Review Rever: JESF TS
Search From Dare To Date

Update Eligibility
Please check CPCMS records for diversion or adjudication cases for pending criminal charges / convictions

Juvenile: [Closed 1/10/2019] Case: [ N IINIEEEE cocke: [ cigivle: 01/16/2024 Qualifying Disposition: Not Approved

Review Status ® Pending O Confirmed Eligible O Submitted / Under Review i)
Eligiblity Reevaluation Dates
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3. Filtering by Eligibility Status
Search results may be filtered by eligibility status. The default status setting is “Review Eligible.”

If a case has beenreviewed and determined to be ineligible, either through system rule calculations
or as a result of user review, it will appear under one of the following status categories:

* Post-Review: Ineligible

e Post-Review: Revoked

s Home ~ Juvenile » Actions ~ Victim ~ Users » Management Tools

Eligible Expungements List

Actions Juvenile ¥ ~ Case Number ¥ * Docket Number ¥ * Type ¥ ™ Status ¥ ™ Qualifying Disposition ¥ *

View » Adjudication  Pending -
View » Adjudication  Pending n
View » Adjudication  Pending m
View » Adjudication Pending

View » Adjudication  Confirmed Eligible

View » Adjudication  Submitted / under review

View » Adjudication  Pending

View » Adjudication Pending

View » 01/10/2018 Pending v
02/02/2024 1) 02/29/2024 |3 (Eligibility Status: ® Review Eligible O Post-Review: Ineligible O Post-Review: Revoked ) Search
Search From Date To Date

Update Eligibility
Please check CPCMS records for diversion or adjudication cases for pending criminal charges / convictions

Juvenile (Closed 1/10/2019)  Case: [ oo« INNNEGEGEGEGE Eligible: 01/16/2024

Review Status: ® Pending O Confirmed Eligible O Submitted / Under Review
Eligibility Revocation Dates

Comments:

F

Update Cancel
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4. Review Eligible

The “Review Eligible” status category displays cases that became eligible within the selected date
range and are awaiting review.

Home - Juvenile - Actions - Victims - Users - Management Tools - Admin Tools

Eligible Expungement List:

Actions  Juvenile ¥  Case Number ¥ Docket Number ¥ Eligibility Date ¥  Type ¥ Qualifying Deposition ¥ Close Date ¥
View 01/02/2024 Adjudication 01122017 =~
View 01/02/2024 Adjudication 01132018
View 11/05/2023 Adjudication 01/032019
View 11/05/2013 Adjudication 01/04/2018
View 01/02/2023 Confirmed Eligible 01/07/2013
View 01/06/2023 Submitted / under review 01/05/2018
View 01/06/2013 awaiting 01/04/2014
View 01/16/2023 Pending 09/10/2018
02282024 2 02/29/2024 |2 Eligiblity Status Post-Review: Ineligible O Post-Review Rever:
Search From Date To Date

Update Eligibility

Please check CPCMS records for diversion or adjudication cases for pending criminal charges / convictions
Juvenile: (Closed 1/10/2019) Case: || NI cocke: IR ciciv'e: 01/16/2024 Qualifying Disposition: Not Applicable

Review Status ® Pending O Confirmed Eligible O Submitted / Under Review ()
Eligiblity Reevaluation Dates
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5. Post-Review: Ineligible

The “Post-Review: Ineligible” status category displays cases that became eligible within the
selected date range but were reviewed and marked “Not Approved” by the user.

s Home ~ Juvenile » Actions » Victim -~ Users v Management Tools » Admin Tools

Eligible Expungements List

Qualifying Disposition W *

Status ¥ ~

Actions Juvenile ¥ ~ Case Number ¥ ~ Docket Number ¥
View » Adjudication Not Approved =
View » Adjudication Not Approved '
View » Adjudication Not Approved
View » 09/17/2017 Not Approved

v

02/29/2024 Eligibility Status: (O Review Eligible (..- Post-Review: Ineligible }( Post-Review: Revoked | Search

To Date

02/02/2024 =
Search From Date

Update Eligibility
Please check CPCMS records for diversion or adjudication cases for pending criminal charges / convictions

Juvenile (Closed 3/6/2018)  Case: || | NN o< | EGGNGEG Eligible: 03/06/2023

Review Status: @® Pending O Confirmed Eligible O Submitted / Under Review i
BB
Eligibility Revocation Dates

Comments:
P

Update Cancel
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6. Post-Review: Revoked

The “Post-Review: Revoked” status category displays cases where the review status, notes, or

review date were updated by the user, and the case is no longer eligible under the system’s

eligibility rule calculation.

® Home ~ Juvenile » Actions » Victim v Users v Management Tools » Admin Tools

Eligible Expungements List

Actions Case Number ¥ *  Docket Number ¥ * Type ¥~ Status ¥ * Qualifying Disposiion W *
View > Adpdication  Confirmed Eligible 06/11/2018 ~
View > Adjudication  Not Approved 12/04/2017
View » Adjudication  Not Approved 10/11 /2017
View » Adjudication  Submitted / Ehgible 1011 /2017
View > Adpdication  Submitted / Under Review 09/01 2017
View > Adjudication  Pending 10/M7207
01/31/2018 Not Approved 09/07/2017
04/04/2019 Not Approved 10112017
ew > 04/04/2019 Post-Review: Revoked 06/12/2018
02/01/2024 (£} 02/29/2024 [ Eligibility Status: O Review Eligible (® Post-Review: Revoked ) Search
Search From Date To Date
Update Eligibility
Please check CPCMS records for diversion or adjudication cases for pending criminal charges / convictions
Juvenile: (Closed 5/31/2018)  Case: ||| R oocke: I Eligible: 05/31/2023
Review Status: @ Pending () Confirmed Eligible () Submitted / Under Review -
Eligibility Revocation Dates
Comments:
Update Cancel
02/02/2024 E 02/29/2024 Eﬂ
Search From Date To Date
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7. Related Records

The “Related Records” function indicates possible involvement with other juvenile probation
offices in Pennsylvania counties, as well as adult docket information retrieved from AOPC through

JNET services.

Home ~ Juvenile -~ Actions ~ Victims ~ Users ~ Management Tools ~ Admin Tools

Eligible Expungements List

05/21/2007

View

View 11/12/2008

View 07/11/2008

View 02/11/2005

View 02/15/2005

View 11/15/2005
01/27/2025 = B 01/27/2026
Search From Date_ To Date

Update Eligibility

Related records

Diversion Pending  Informal Adjustment - 07/23/2024 09/24/2025
Diversion Pending  Informal Adjustment - 12:30/2024 07/31/2025
Diversion Pending  Informal Adjustment - 09/11/2024 02/24/2025
Diversion Pending 01/16/2024
Adjudication Pending 01/16/2024
Adjudication Pending 01/15/2024
Eligibility Status: ® Review Eligible © Post-Revew: Ineligible © Post-Review: Revoked Search

Please check CPCMS records for diversion or adjudication cases for pending

criminal charges / convictions

Eligible: 01/24/2026

suveniile: [N C-<- I oo I

February 2026

Juvenile Court Judges’ Commission

Qualifying Disposition - 07/23/2024

Page 42

Pennsylvania Judicial Center | 601 Commonwealth Avenue, Suite 4600
P.O. Box 62425 | Harrisburg, PA 17106 | 717.787.6910 | F. 717.783.6266 | www.pa.gov/agencies/jcjc



https://www.pa.gov/agencies/jcjc

8. Reviewing Related Records

Click “Related Records” to review potential cross-county involvement and/or adult docket
information.

Related Justice Records Forl

Cross County Search

The selected Juvenile may exist in Berks county and should be contacted for confirmation.

Adult Case List

Adult docket information is retrieved from AOPC via JNET services. The system searches by State Identification
Number (SID) first, if no search is performed using Social Security Number (SSN). Only the lead charge listed on
the adult docket is displayed.

Filing Date Case Status Lead Charge = Docket Number Lead Charge Description

2023-11-20 Inactive 18 3304 A5 Criminal Mischief - Damage Property

2023-05-16 Inactive 18 5505 Public Drunkenness And Similar Misconduct

2023-02-27 Closed 18 3929 A1 Retail Theft-Take Mdse

2022-07-06 Closed 18 2701 A1 Simple Assault.

2022-05-14 Closed 18 3502 A1 Burglary - Overnight Accommodations;

Person Present, Bodily Injury Crime

2020-01-08 Closed 18 3925 A Receiving Stolen Property

2019-12-27 Closed 18 3925 A Firearms Not To Be Carried WO License

2020-01-08 Closed 18 3925 A1 Receiving Stolen Property

2019-12-27 Closed 18 6106 A1l Firearms Not To Be Carried W/O License
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PaJCMS CASES ELIGIBLE FOR EXPUNGEMENT BY ELIGIBILITY DATE AND
TYPE REPORT

The PaJCMS Cases Eligible for Expungement by Eligibility Date and Type report categorizes eligible
cases as either currently eligible or upcoming eligible within the specified date range. Cases are further
organized by eligibility type. For adjudication eligibility, cases are grouped into two-year misdemeanor and
five-year felony categories. A summary at the end of each section of the report provides the total number

of cases for the adjudication eligibility type. For diversion and dismissed/withdrawn eligibility, the
summary breaks down cases by disposition type.

Upcoming Cases Eligible for Expungement
with and Eligibility Date between 3/1/2025 and 4/10/2025

Start Date: | 3/1/2025 [E  End Date: |4/10/2025 B Eligibility Type: | Adjudication, Dismissed v

Adjudication- 2 year misdemeanor

Eligbility Date Eligibility Status ~ Review Date =~ CPCMS Docket # / Case Number Referral Date Juvenile Closed
3/23/2025 2021-000139 8/2/2021 3/23/2023
3/23/2025 2022-000072 3/8/2022 3/23/2023

Adjudication Cases Eligible Diversion Cases Eligible Dismissed/Withdrawn Cases Eligible

9 DISPOSITION Total DISPOSITION Total
Consent Decree 15  Allegation withdrawn 1
Fined and Costs / Non-Court 3 Petition withdrawn 3
Ordered Total —a
Informal Adjustment Consent 3
Total D
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Start Date: | 4/11/2025 1 End Date: | 5/31/2025 |8 Eligibility Type: Adjudication, Dismissed ~

Diversion

Upcoming Cases Eligible for Expungement
with an Eligibility Date between 4/11/2025 and 5/31//2025

Eligibility Date Eligibility Status CPCMS Docket # / Case Number Referral Date Juvenile Closed Date

Qualifying

10/19/2024 2023-000426 10/2/2023 4/19/2024 Consent Decree

February 2026

Alleged Charges -18550111F3; 182701A1A3; 185503A1S

Diversion Cases Eligible

DISPOSITION Total
Consent Decree 3
Total 3
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EXPUNGEMENT POLICY TEMPLATE

[COUNTY NAME] JUVENILE PROBATION OFFICE

POLICY AND PROCEDURE

SUBIJECT: Expungement and Retention of Juvenile Records
EFFECTIVE DATE: [Insert Date]

REVISED DATE(S): [Insert Date(s)]

APPROVED BY: [Chief Juvenile Probation Officer/President Judge]

I. PURPOSE

The purpose of this policy is to establish standardized procedures for the expungement, destruction,

and limited retention of juvenile records in accordance with Pennsylvania law. This policy is intended to:

1. Promote uniform, lawful, and timely expungement of eligible juvenile records.

2. Supportyouth rehabilitation by minimizing unnecessary collateral consequences.

3. Ensure compliance with statutory requirements and Pa.R.J.C.P.

4. Preserve limited information where authorized by law for court-related purposes.

Il. LEGAL AUTHORITY

This policy is governed by, including but not limited to:

18 Pa.C.S. § 9123 (Expungement of Juvenile Records)
42 Pa.C.S. 86301 et seq. (Juvenile Act)
Pa.R.J.C.P.170-173

Act 108 of 2024

Applicable case law and administrative directives

Il. POLICY STATEMENT

It is the policy of the [County Name] Juvenile Probation Office to identify, initiate, and process

expungement of juvenile records promptly and automatically when eligibility criteria are satisfied, unless

expungement is expressly prohibited by law.

The juvenile probation office shall ensure:
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e Consistent notification to the court when expungement eligibility is reached
e  Compliance with all statutory timelines
* Protection against unauthorized access to expunged information
* Retention only of limited information as permitted by law
I1l. RESPONSIBILITY

A. Chief Juvenile Probation Officer
The chief juvenile probation officer, or designee, is responsible for:
* Ensuring compliance with expungement statutes
* Notifying the court when expungement eligibility is met
e Designating staff to track and process expungements

B. Designated Expungement Staff
Designated staff shall:
e Track expungement eligibility dates
e Conduct criminal history checks
* Prepare motions, proposed orders, and distribution lists
e Ensure destruction of records upon court order

IV. IMMEDIATE AND AUTOMATIC EXPUNGEMENTS

The juvenile probation office shall initiate expungement immediately in the following circumstances:

e Written allegation not approved for prosecution
* Petition dismissed or withdrawn
¢ Court finds the juvenile did not commit the alleged acts
e Court finds the juvenile not in need of treatment, supervision, or rehabilitation
In these cases, expungement may proceed sua sponte, without a waiting period.
V. EXPUNGEMENT ELIGIBILITY BY CASE TYPE

A. Informal Adjustment/Diversion

February 2026
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e Eligibility: Six months after successful discharge
e Conditions:

o No pending adjudication or conviction

. Consent Decree

e Eligibility: Six months after successful discharge
e Conditions:
o No pending adjudication or conviction

. Adjudicated Delinquency - Misdemeanor (excluding firearms (18 Pa.C.S. Chapter 61) and specified
sexual offenses (18 Pa.C.S. § 3126(a)(2) or (3))

e Eligibility: Two years after final discharge
* Conditions:
o No subsequent felony, misdemeanor, or delinquency adjudication
o No pending proceeding
. Adjudicated Delinquency - Felony, Firearms, or Specified Sexual Offenses
e Eligibility: Five years after final discharge
* Conditions:
o No subsequent felony, misdemeanor, or delinquency adjudication
o No pending proceeding
o Offense not precluded by 18 Pa.C.S. 89123(a.1)
DA Consent

*  Expungement may occur at any time with the consent of the attorney for the Commonwealth,
unless prohibited by law.

VI. OFFENSES NOT ELIGIBLE FOR EXPUNGEMENT

Records shall not be expunged when:

* The juvenile was 14 years or older at the time of the offense, and

* The offense would constitute the following if committed by an adult:
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o

Rape (18 Pa.C.S. 8 3121)
o IDSI(18Pa.C.S.§3123)
o Aggravated Indecent Assault (18 Pa.C.S. 8 3125)
o Attempt, solicitation, or conspiracy of the above.®
VIl. EXPUNGEMENT PROCESS
Step 1: Eligibility Review
* Review case disposition and eligibility date
* Conduct a full criminal history check
Step 2: Motion Preparation
* Prepare Motion for Expungement (or sua sponte motion)
o Each motion shallinclude:
= Juvenile’s full name
= DOB
=  Docket number(s)
= Allegations and disposition
= Law enforcement agency involved
= Arrest date and report number (if applicable)
= Statutory basis for expungement
= Complete distribution list
Step 3: DA Review
* File motion with Clerk of Courts
* Provide time-stamped copy to DA

e DAhas 30 days to object

8 See 18 Pa.C.S. §9123(a.1).
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Step 4: Court Action
e Ifno objection, submit to court for signature
* If objection, schedule hearing
Step 5: Record Destruction
Upon receipt of a signed order, the juvenile probation office shall:
* Expunge all juvenile probation office records, including electronic records (e.g., PaJCMS)
* Retain a copy of the court order in a secure, limited-information file
e Distribute certified orders to all listed agencies
VIIl. DISTRIBUTION OF EXPUNGEMENT ORDERS
Orders shall be distributed to all relevant agencies, including but not limited to:
e PSP
* FBI
e Law enforcement agencies
* DA
* Clerkof Courts
* Juvenile’s counsel
e School district (with destruction request)
IX. RETENTION OF LIMITED INFORMATION

Pursuant to Pa.R.J.C.P. 173, the juvenile probation office may retain limited identifying information in
arestricted location for lawful purposes only, including:

* Juvenile name and DOB

* Docket number

e Alleged and adjudicated offenses
e Casedisposition

This information shall not be disclosed, referenced in reports, or used in risk assessments. No

additional records shall be retained unless authorized by law.

February 2026 Page 50
Juvenile Court Judges’ Commission
Pennsylvania Judicial Center | 601 Commonwealth Avenue, Suite 4600
P.O. Box 62425 | Harrisburg, PA 17106 | 717.787.6910 | F. 717.783.6266 | www.pa.gov/agencies/jcjc



https://www.pa.gov/agencies/jcjc

X. INTERCOUNTY CASES
* Expungement motions shall be filed in the county of adjudication
* Courts shall direct expungement orders to all counties holding records
XI. FINANCIAL OBLIGATIONS
Expungement shall generally not be processed where:
e Restitution or court-ordered financial obligations remain outstanding
e Judgments are unsatisfied

Upon full satisfaction of financial obligations, expungement may be reconsidered if other criteria are

met.
XIl. COMPLIANCE AND CONFIDENTIALITY
Unauthorized disclosure of expunged information may result in:
* Corrective action
*  Formaldiscipline through Court Administration
Xlll. EFFECTIVE DATE AND REVIEW

This policy shall take effect upon adoption and shall be reviewed periodically to ensure compliance
with statutory changes and statewide guidance.
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FREQUENTLY ASKED QUESTIONS (FAQ)

1. Q: Do you have to wait five years after an adjudication of delinquency to expunge a
misdemeanor or summary offense?

A: No, a misdemeanor or summary offense may be expunged when the attorney for the
Commonwealth consents to the expungement.”®

2. Q:Can acase thatis withdrawn in court be expunged immediately?
A: Yes, cases withdrawn in court should be expunged immediately.

3. Q: For juveniles who have one case withdrawn, but other cases open, should the withdrawn
case be expunged immediately, or do all cases need to be closed before the expungement is
processed?

A: The withdrawn case may be expunged immediately.

4. Q: Should a case be expunged immediately for a juvenile who goes to court on a delinquency
matter but is found guilty only of a summary offense, receives no supervision, and is closed
immediately as there are no costs or fines ordered?

A: Yes, the case should be expunged immediately. Counties should use the “Termination of Court
Supervision/Case Closed, Summary Charge” disposition in PaJCMS, and that disposition is
programmed to fit the dismissed/withdrawn, expungement criteria. Since all delinquent charges
were dismissed/withdrawn, the overall case now needs to be treated as a dismissed/withdrawn
scenario and thus eligible for immediate expungement.

5. Q:Can summary Magisterial District Judge (MDJ) cases be expunged by the juvenile probation
office?

A: Yes, MDJ cases can be expunged by the juvenile probation office for persons under 18 years of
age as long as the requirements are met. Two expungement petitions would need to be filed. One
would be filed pursuant to Pa.R.J.C.P. 170 to expunge the record of the juvenile proceeding, and
the second would be filed pursuant to Pa.R.Crim.P. 490 to expunge the underlying summary
conviction.

6. Q: Howdo I proceed with the expungement of a case decertified from adult court?

A: File a motion where the adjudication took place (juvenile court) and include the criminal division

70See Pa.R.J.C.P.170.
February 2026 Page 52
Juvenile Court Judges’ Commission
Pennsylvania Judicial Center | 601 Commonwealth Avenue, Suite 4600
P.O. Box 62425 | Harrisburg, PA 17106 | 717.787.6910 | F. 717.783.6266 | www.pa.gov/agencies/jcjc



https://www.pa.gov/agencies/jcjc
https://www.pacodeandbulletin.gov/Display/pacode?file=/secure/pacode/data/237/chapter1/s170.html&d=reduce

docket number on the order along with the juvenile court docket number.

7. Q:Arejuvenile probation offices responsible for processing expungements per Act 108 of 2024
that took effect April 16, 2025, or are the requirements of the Act from the effective date
moving forward?

A: The Act does not require offices to process expungements retroactively. However, cases that
met the eligibility requirements prior to the effective date of the Act should already have been
expunged.

8. Q: Whatinformation from an expunged record can a juvenile probation office retain?

A: For statistical and research purposes, the juvenile probation office, the JCJC, and the AOPC may
maintain the following information in a separate document, file, or database for statistical and
research purposes:

e alist of juvenile names;
¢ identifying information, such as DOB;
e demographic information;
¢ alist of the delinquent acts alleged or petitioned,;
¢ alist of the delinquent acts found, if applicable;
e the disposition of the case; and
e anyrecidivism information.”
9. Q: Do counties need to retain expungement orders?

A: Yes, according to Pa.R.J.C.P. 173, a copy of the order must be retained in a separate document,
file, or database for the purpose of determining compliance with an expungement order.
Expungement orders are considered “permanent” records and may not be destroyed unless
replicated pursuant to the Pennsylvania Supreme Court’s Record Retention and Disposition
Schedule with Guidelines.”?

10. Q: What is the difference between JNET and CLEAN certifications?

A: INET is the Commonwealth’s justice data network that connects systems and users, while
CLEAN is a law enforcement database containing criminal justice information that requires
separate, stricter certification. A CLEAN certification provides JNET users access to the FBI

71 See Pa.R.J.C.P. 173.
72 See 204 Pa. Code § 213.51.
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11.

12.

13.

14.

15.

16.

17.

National Crime Information Center (NCIC) and the International Justice and Public Safety
Information Sharing Network (Nlets).

Q: Do staff responsible for processing expungements need to be CLEAN-certified?

A: No, staff responsible for processing expungements do not need to be CLEAN-certified unless
their job duties include direct access to the CLEAN system. Act 108 of 2024 imposes procedural
duties but does not create any certification or credentialing requirement for expungement
processing staff.

Q: Do you need to be CLEAN-certified to run a rap sheet?

A: You only need to be CLEAN-certified to run a CLEAN background check. Otherwise, it would not
be required.

Q: Do staff responsible for processing expungements need to be JNET-certified?

A: No, staff responsible for processing expungements do not need to be JNET-certified unless their
job duties include direct access to the JNET system. Act 108 of 2024 imposes procedural duties but
does not create any certification or credentialing requirements for expungement processing staff.

Q: Does reviewing the related offense tab alleviate the need to run a rap sheet?

A: Therelated offense tab does look at other counties for correlating the state identification number
(SID), social security number (SSN), first and last name, and DOB records. If it is in your normal
practice to run a rap sheet, you will continue to follow that process because if the other county has
an error in any of those fields, it will not pull the correlating information.

Q: Do juvenile probation offices need to remove the eligibility reevaluation date in the PaJCMS
Expungement Eligibility Dashboard after eligibility has been confirmed?

A: Once eligibility is confirmed, navigate to the expungement module in PaJCMS to expunge that
record and the eligible date or review status will no longer appear.

Q: When a juvenile record search produces adult charges and shows the record is not eligible
for expungement at that time, what is the next timeframe to reevaluate expungement
eligibility?

A: Act 108 of 2024 only speaks to originating offense rules and does not address reevaluation
timeframes. However, the court can be notified and specify an expungement reevaluation date at
its discretion. It is not required to use a reevaluation date in the PaJCMS Expungement Eligibility
Dashboard.

Q: If a case has been restored from the archive to PaJCMS, and then the case gets expunged
in PaJCMS, does it get expunged in the archive as well?
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A: Yes, the expunged juvenile record will also be expunged in the archive.
18. Q: Where does the data for the Allegations Expunged During a Time Period report come from?

A: The report pulls data from actual expungement actions, not the PaJCMS Expungement Eligibility
Dashboard. It counts only records that were fully expunged during the selected time period, based
on when a user clicks to expunge a case. It does not include cases that are only marked as eligible
or confirmed for expungement, only those that have been fully expunged.

February 2026 Page 55
Juvenile Court Judges’ Commission
Pennsylvania Judicial Center | 601 Commonwealth Avenue, Suite 4600
P.O. Box 62425 | Harrisburg, PA 17106 | 717.787.6910 | F. 717.783.6266 | www.pa.gov/agencies/jcjc



https://www.pa.gov/agencies/jcjc

	INTRODUCTION
	PURPOSE
	JUVENILE RECORDS AND FILES
	Definitions
	Inspection of Official Court Records
	Inspection of Juvenile Probation Files
	Authorizing the Inspection of Official Court Records and Juvenile Probation Files
	Dissemination of Official Court Records and Juvenile Probation Files
	Release of Information to Schools
	Public Availability
	Public Disclosure of Information Based Upon an Adjudication of Delinquency
	Public Disclosure of Information Based Upon a Petition Alleging Delinquency
	Employment and Military Service

	Collateral Consequences
	Subsequent Judicial Matters
	Post-Secondary Education
	Suspension of Motor Vehicle Operating Privileges
	Felony Adjudications (Vehicle Involved)
	Vehicle Code Violations (non-Driving Under the Influence (DUI))
	DUI-Related and Drug-Related Offenses
	School-related Offenses
	Truancy-related Dispositions
	Suspension of Operating Privileges at the Court’s Discretion

	Possession or Purchase of a Firearm
	Use of Delinquency Adjudications for Criminal Sentencing Purposes
	Lapsing of Juvenile Adjudications


	Record Retention

	LAW ENFORCEMENT RECORDS
	Definitions
	Public Availability
	Fingerprints and Photographs
	Juvenile History Record Information

	DNA SAMPLES
	Definitions
	DNA Collection

	EXPUNGEMENT OF JUVENILE RECORDS
	Definitions
	Requirements for the Expungement of Juvenile Records
	Expungement Process
	Expungement Orders
	Distribution of Expungement Orders
	Expungements of Intercounty Transfer of Delinquency Cases
	Expungement of DNA Records
	Expungement of Pennsylvania Department of Transportation (PennDOT) Records

	PENNSYLVANIA JUVENILE CASE MANAGEMENT SYSTEM (PaJCMS)
	PaJCMS Expungement Eligibility Dashboard
	PaJCMS Reports

	PaJCMS EXPUNGEMENT ELIGIBILITY DASHBOARD USER GUIDE
	PaJCMS CASES ELIGIBLE FOR EXPUNGEMENT BY ELIGIBILITY DATE AND TYPE report
	EXPUNGEMENT POLICY TEMPLATE
	FREQUENTLY ASKED QUESTIONS (FAQ)



